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In-depth QCC Print Manager Webinar
The purpose of this webinar is to expose participants in greater detail to the unique 
features of the QCC Print Manager Module.  There is not sufficient time, however, to 
cover every topic in detail.  Users are referred to the manual Printing Reports with 
Print Manager, published February 2008, for additional information and detailed 
explanations.

Print Manager Dataform

As discussed in the Introduction to QCC / Print Manager webinar, Print Manager is 
the QCC equivalent of LSPOOL in the traditional environment.  However, Print 
Manager contains many more options and abilities than were present in the traditional 
LSPOOL.  This webinar will deal in greater detail with a number of those additional 
capabilities. 

Topics to be covered include the following:-

• Configuring User Preferences 
• User Selection Options
• Other Print Manager Tabs
• Viewing and Managing Print Files
• Printing a Report
• Creating a PDF File
• Opening a File in Word or Excel
• Opening a File with Excel Wizard
• The Grid Output Window
• Downloading Files
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Configuring User Preferences Within Print Manager 
Preferences are defined on the File menu.  The following dataform displays when you 
select the Preferences option. 

Most of these items are self-explanatory.  A few require further explanation.

Delete file from 
server after printing? 

This preference sets the default in relation to the deletion of 
print files.  There is the capability to override this default when 
selecting a file to print.

Months in the past to 
limit the search for 
Print Files

This option limits the number of months that print files will 
remain in your Print Manager. The choices range from 1 to 60 
months with the [Maximum] option being that all of the user’s 
files will be displayed.
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Remove first blank 
line when using 
Special (pcl or 
macro form)

Select this check box only if QSS instructs you to do so. 

In some cases, Print Manager adds an extra line while print-
ing POs or other special forms.

Using Print Manager to View Files Created by Other Users
Another selection on the File menu is Select User(s).  This option, when coupled with 
the appropriate security clearances, allows you access to the Print Manager files 
created by other users.  When selected, the following dataform appears with a drop-
down list of users to whom you have access.

Select the users whose print files you wish to access by clicking on their log-on name.  
The icons allow you to [Get User(s) Files (Ctrl+F1)], [Select All (Ctrl+F2)], [Select 
None (Ctrl+F3)], or [Cancel (F12)].  Note that there are hotkey combinations 
available for each of these selections.
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Print File User Selection Options
Incorporated into each user listing in Print Manager are four ways of organizing the 
data to make report selection easier.  In addition to seeing all of the available reports 
listed on the grid portion of the Print Manager dataform, you can also request the list 
by date, by job number, by type of report, or by user-defined report title.

When selecting by date, you can click upon a date on the displayed list to have only 
the reports generated on that date appear in the grid portion of Print Manager.

When selecting by [Job Number], the displayed list will include the job numbers of 
all the reports in your Print Manager.

When selecting by [Program Title], the displayed list will include the various types of 
reports that you have created.  Click on the type report that you are searching for and 
only listings for those reports will display in the grid area.

Selecting by [Report Title] will produce similar results.
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Other Print Manager Tabs 
There are four tabs in addition to the Print Files tab available in the Print Manager 
module.  A green dot indictes the tab that is currently open.

Spool Files/$STDLIST
The SpoolFiles/$STDLIST tab contains information on various types of system files 
that you can now access without having to know special server commands.  With 
access to this tab, you will be able to see how your job ran on the server and all of the 
parameters that you passed on to the program when you launched the job.

The [User] selection drop-down list above the grid allows you to select the user 
whose files you wish to review.  The list of users to which you have access is 
controlled by security settings.
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Local Print Files
The Local Print Files tab shows the print files saved on your PC .  

If you set your Preferences on the File menu to not remove local files on exit, then 
these files would remain on the Local Print Files tab until you delete them.

To select the type of local file that you wish to view, set the radio button at the top of 
the tab to [Report files] for regular report files or to [Output/$STDLIST] for spool 
files created when a job was executed.  

In both cases, the column headings for the file type displayed on the Local Print Files 
tab are similar to those on the main Print Files or Spool Files/$STDLIST tabs with the 
addition of a [Local file name] field.  The [Local file name] can be used with the 
search function on your PC to locate the file on your work station.  

Figure 1: Reports on Local Print Files tab

Figure 2: Output/$STDLIST on Local Print Files tab
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Session History 
The Session History tab will display all of the activity that has gone on in this module 
since you loaded it.  Each time the module is loaded the Session History area is blank.  
Activity is logged only for the session you are currently in.

Server Commands 
This tab gives you easy access to several common Version H server commands.  
General access is available to the first three commands, while the other commands are 
password protected.  

The [Showjob=@J] command is comparable to entering a ’JJ’ in the option field of a 
traditional menu screen to see ’Just the Jobs’ that are currently running.  

The [Showjob=@S] command is comparable to entering a ’JS’ in the option field of a 
traditional menu screen to see ’Just the Sessions’ that are currently running. 
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The [Showjob] command is comparable to entering a ’J’ in the option field of a 
traditional menu screen to see both the jobs and the sessions that are currently 
running.

The other server commands listed are available for use by the technical staff and 
require specific requested parameters and a password in order to execute the 
command.
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Viewing and Managing Print Files
A View window opens whenever you open a file from any of the following tabs on the 
Print Manager window:

• Print Files tab
• Spool Files/$STDLIST tab
• Local Print Files tab

To Open a Print File 
From any of the three tabs noted above, you can use any one of three different 
methods to open an item into the View window. 

• Single left-click in the [Ret.] column on the yellow open folder.  This will open the 
report or file on that line of the grid.  To move the yellow open folder icon to 
another row, single-click the [Ret.] column for that row.

• Double left-click anywhere other than in the [Ret.] column on the desired row.
• Single right-click anywhere other than in the [Ret.] column on the desired row.  

This will open a small window which lists several actions that you can take.
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The View Window
The following illustrates the text area for the View window. The text area displays the 
print file or spool file that you selected from the Print Manager window. You can use 
the Options menu commands or command icons to resize the text, print the file, or 
export the file to another Windows application.

   

 

NOTE: Your system administrator can configure Print Manager so that all you can do is dis-
play reports, print, and route. 

For this limited access, the following commands are grayed out: Download File, Create 
PDF, Send to Word, Send to Excel, Send to Excel Wizard, and Copy Selection to Clip-
board.
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Table 2-1: Menu commands and toolbar icons for the View window 

MENU 
COMMAND

ICON  KEYBOARD 
SHORTCUT

PURPOSE

Options | 
Open...

CTRL+O Open a new View window for the indicated print 
file.

Options | Print... CTRL+F11 Print the file to a Windows printer set up for your 
PC. A Print Report dialog box displays.

Options | 
Route...

CTRL+R Use Print Manager to route the print file or spool 
file to a spooled printer on the HP e3000 server. A 
Route to Printer dialog box displays.

Options | 
Download File...

CTRL+D Open a Download window that allows you to 
extract data from the file and create a comma- or 
tab-delimited file for importing the data into a data-
base or spreadsheet. 

Options | Create 
PDF...

CTRL+F Create a PDF file that contains the file in the cur-
rent window. 

Options | Open 
in Word...

CTRL+W Open a new window in Microsoft Word that con-
tains the file in the active View window.

Options | Open 
in Excel...

CTRL+L Open a new workboo
k in Microsoft Excel with the contents of 
the file in the active View window. Each 
line of the file becomes a single column in 
the spreadsheet.

Options | Open 
with Excel 
Wizard...

CTRL+Z Import the file in the current window into Microsoft 
Excel with the Text Import Wizard. The wizard 
allows you to define the column widths and data 
type for each column.

Options | 
Search for Text

F3

Search the print file or spool file in the current 
View window. To begin the search, type the 
search text. The search is not case sensitive, and 
it does partial word matches. 

Options | 
Search for Text 
Backwards

none SHIFT+F3 Search backward in the current file for the search 
text.

Options | First 
Page

SHIFT+F5 Go to the beginning of the first line in the file.

Options | 
Previous Page

F5 Go to the previous page in a print file. This search 
works only for reports that have standard page 
numbers on the upper right corner of each page.
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Moving through Text
Whenever the print file or spool file is too large to fit in the View window, the text 
area displays horizontal and vertical scroll bars. 

To move through the text, do any of the following:
♦ Use the scroll bars.
♦ Use the standard Windows keys, such as PAGE UP, PAGE DOWN, LEFT 

ARROW, and RIGHT ARROW.
♦ If you have a wheel mouse, click inside the text area, then use the mouse wheel to 

scroll through the text.

♦ Search for text with the   [Search for Text] icon. 
◊ Type the search text.
◊ To search forward, press ENTER, press F3, or click the magnifying glass icon.
◊ To search backward, press SHIFT+F3.

♦ Move through the pages of a print file with the  VCR icons.
◊ To go to the first page, click the   [First Page] icon or press SHIFT+F5.
◊ To go to the next page of a print file, click the  [Next Page] icon or press F6.

◊ To go to the previous page of a print file, click the  [Previous Page] icon or 
press F5.

◊ To go to the end of a file, click the  [Last Page] icon or press SHIFT+F6.

Options | Next 
Page

F6 Go to the next page in a print file. This search 
works only for reports that have standard page 
numbers in the upper right corner of each page.

Options | Last 
Page

SHIFT+F6 Go to the end of the last line in the file.

Options | 
Search for Page

   CTRL+F3 Go to a specific page number in a print file. To do 
so, type a page number, then do any of the follow-
ing: click the magnifying glass icon, press 
CTRL+F3, or press ENTER. This search works 
only for reports that have standard page numbers 
on the upper right corner of each page.

Options | Copy 
Selection to 
Clipboard

CTRL+C Copy the selected text to the Windows clipboard. 
You can select text with the mouse or the key-
board equivalents.

Options | Hide 
View

CTRL+H Hide the current View window. The window 
closes. You can reopen it from the view manager 
on the Print Manager window. 

Table 2-1: Menu commands and toolbar icons for the View window (Continued)

MENU 
COMMAND

ICON  KEYBOARD 
SHORTCUT

PURPOSE
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♦ Go to a specific page number of a print file with the  [Search for Page] icon. 
Type a page number, then press ENTER, press CTRL+F3, or click the magnifying 
glass icon.

Resizing Text and the View Window
After you open a View window, it opens to the default size and displays the print file 
in the default font size. You can resize both the window and the text that displays in it.

To change the font or window size, do any of the following:
♦ To change the default font size, select a size in the Preferences dialog box. By 

default, the initial font size is 7.5 points. You can change it to anywhere from 2 
through 20 points. 

♦ To resize the text in the current window, hold down the CTRL key, then rotate the 
mouse wheel.

♦ To resize the View window, use the standard Windows techniques.

Copying and Pasting
You can select all or part of the text in the View window, copy it to the Windows clip-
board, and then paste the text into another Windows application. 

To copy and paste text:
1 Move the cursor to the start of the text you want to copy.

2 Highlight the text to copy in any of the following ways:

◊ Click and hold the left mouse button, then drag the mouse pointer to highlight 
text.

◊ Press CTRL+A to select the entire file.

◊ Select text line by line with the SHIFT key.

> Press and hold the SHIFT key to anchor the starting point for the selection.
> Press the UP ARROW key to highlight the previous line of text, or press the 

DOWN ARROW key to highlight the next line of text.
> When you have finished selecting text, release the SHIFT key. 

NOTE: The [Previous Page], [Next Page], and [Search for Page] commands work 
only on print files with standard page headings. They search for the word PAGE fol-
lowed by a number in the heading line for print files.
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3 Copy the selected text to the Windows clipboard. To do so, click the  [Copy to 
Clipboard] icon.

4 Navigate to another Windows application and paste the text. 

To paste, press CTRL+V or use the appropriate menu command for the applica-
tion.
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Printing a Report
There are two command icons that can be used to print a report: 

The [Print] icon (CTRL+F11) opens a Print Report dialog box 
that allows you to print the file or files that you have selected 
on any printer that you can select from Windows. This printer 
can be either a networked printer or one that is attached to your 
PC.

The [Route] icon (CTRL+R) opens a Route to Printer dialog 
box that allows you to route the file or files that you have 
selected to a spooled printer that is attached to the HP e3000 
server at your county or district office. Your reports go into the 
print queue along with the reports that other people send to the 
printer.

If you have selected multiple files on the Print Manager window, the [Print] and 
[Route] icons print or route all of the selected files.

Print Report Dialog Box
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You can open a Print Report dialog box from the following places:

• The Print Files tab
• The Spool Files/$STDLIST tab 
• The Local Print Files tab
• A View window

Print Profiles
Print profiles are an option that allows you to save settings for how to print reports. 
You can specify the printer to use, format file, and number of copies. 

To use a print profile:
1 For the Type, select Private or Global. 

A private print profile is only for your user name. A global print profile is one that 
anyone can use.

Table 1-2: Option menu commands and Toolbar icons for the Print Report dialog box 

OPTION MENU 
COMMAND

ICON AND KEYBOARD 
SHORTCUT

PURPOSE

Save Profile F9 Save the print profile that displays in the 
Name field. The next time you retrieve the 
print profile, the Output Print Settings will 
look just as they do when you clicked the 
[Save] button. 

Cancel Profile 
Change

CTRL+F2 Cancel any changes you have made to the 
print profile on the screen.

New Profile CTRL+F6 Create a new print profile. 

Print CTRL+F11 Print the selected file or files on a Windows 
printer selected on the Printer drop-down 
list. 

Delete Profile CTRL+F8 Delete the print profile that you are currently 
using.
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2 From the Name list, select the print profile that you want to use.

3 Click the  [Print] icon (CTRL+F11).

To add a print profile:
1 For the Type, select Private or Global. 

2 Click the  [New] icon (CTRL+F6).

3 Give the print profile a name. 

A dialog box prompts for the profile name. Type the name and select [OK].

4 Select the Output Profile Settings that you want to define this profile. See below 
for more information about Output Profile Settings.

5 Click the  [Save] icon (F9) to create the new profile.

To change a print profile:
1 For the Type, select Private or Global. 

2 From the Name list, select the print profile that you want to change.

3 Make any needed changes to the Output Profile Settings. .

4 Click the  [Save] icon (F9).

To delete a print profile:
1 For the Type, select Private or Global. 

2 Select the print profile to delete from the Name drop-down list.

3 Click the  [Delete] icon (CTRL+F8).
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Output Profile Settings

Table 1-3: Output Profile Settings for the Print Report dialog box 

COLUMN EXPLANATION

Printer Select a printer from the drop-down list. This list includes all the Windows print-
ers that are set up on your PC.

Format File Select a format file from the drop-down list. The default format file for your site 
is selected. You can use the drop-down list to select another format file.

Copies By default, one copy of the report prints. To print multiple copies, type the num-
ber of copies that you want.

For the remaining fields, the following rules apply.
♦ If you select a format file in the Name list, the fields have a gray back-

ground, which means they are display-only. The fields display the set-
tings from the format file.

♦ If you select **No format file selected** in the Name list, the back-
ground turns white, which means you can select these options. 

Vertical line 
movement

This option is not presently implemented. You cannot alter the line spacing that 
was used when the report was created.

Font The only choice is Courier New.

Font Size Select a font size from the drop-down list.
For landscape printing, 8 points is a good size for most fonts. For portrait 

printing, use a smaller size, such as 6 points.

Print Orientation Select Landscape or Portrait from the drop-down list.

Top Margin Select the top margin from the drop-down list.

Left Margin Select the left margin from the drop-down list.

The gray background 
indicates that these 
selections are made in the 
Format File, and you 
cannot change them.

To make these selections 
yourself, select **No format 
file selected ** in the 
Format File drop-down list. 
The background turns 
white, which means you 
can change the fields.
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Single Session Options
The Single Session Options are options that apply only to the current print job. 

Figure 0-1: Single Session Options for the Print Report dialog box

Table 1-4: Single Session Options for the Print Report dialog box 

COLUMN EXPLANATION

Print Pages 
From
To

Leave blank, or type a range of page numbers. 

Delete after print
or blank

This box displays only if you get to select whether to keep the print file.
If this box does not display, your system has selected one of the following 
options:
• Always keep the print file on the server after printing.
• Always delete the print file from the server after printing.
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Route to Printer 
The Route to Printer dialog box opens after you select the  [Route] command icon 
from the Print Manager window or a View window. This dialog box allows you to 
route a file to a spooled system printer on the HP e3000 server. 

Options for Routing Reports

Table 1-5: Options for routing reports from the Route to Printer dialog box 

COLUMN EXPLANATION

Route File The name of the file being routed displays.
♦ For the Print Files tab, the name is the print file produced by Print Man-

ager. This file resides in the account listed in the tab.
♦ For the Spool Files/$STDLIST tab, the name is the output file for the 

$STDLIST for creating a report.
♦ For the Local Print Files tab, the name is the job number followed by 

OUT.HPSPOOL. 

Printer Select a printer from the drop-down list.

Format File Select a format file from the drop-down list. The default format file for your site 
is selected. You can do the following:

♦ Select another format file from the drop-down list.
♦ Type the name of a format file to use. 
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Deleting Print Files 
To delete print files, use the [Delete File(s)] icon, the [Ctrl + F8] hot key combination, 
or the selection on the Options menu.  

If all of the print files have an N in the [Slct] colum, the only file that will be 
deleted is the one with the big yellow open folder in its [Ret.] column.

If one or more files have a Y in the [Slct] column, delete those files.

 

Special Forms Leave blank, or type a forms message.
♦ Leave blank for reports that print on regular paper.
♦ Type a forms message up to 48 characters long for a print job that 

requires special forms, such as report cards or mailing labels.

Environment File Leave blank, or type an environment file.
♦ Leave blank for reports that print on regular paper.
♦ Type a file name up to 26 characters long to use an environment file for 

controlling specific laser printers. 

Copies Select the number of copies from the drop-down list.

Output Priority If this list has a shaded background, you cannot change the priority.
If this list has a white background, you can change the output priority for print 
files. In most cases, leave the priority at 8.

Delete After Route
or blank

This box displays only if your site allows choosing whether to save or delete 
print files. 

Output Record Size The default size is 132 characters. You can type a different record size.
 Change the record size only when special circumstances require it.

From Page 
To Page

If you want to print only part of the report, type a page range.
To print a single page, type the same page number in the From Page and 

To Page. 

Table 1-5: Options for routing reports from the Route to Printer dialog box (Continued)

COLUMN EXPLANATION
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Creating a PDF File 
1 A Create PDF dialog box displays after you click the  [Create PDF] icon or 

press CTRL+F. 

The choices that you type in this dialog box are "sticky":

◊ The Output path remains the same until you type another one or clear it by 
clicking the  button to reset the default output path.

◊ The PDF Attributes remain the same until you type different ones or click the 
 (Reset to Defaults [Ctrl+D]) command.

The system saves the options you type and uses them again the next time you log 
in to QCC.

              2  Leave the Input file as is.

The box displays the full path to the PrintFiles folder for your QCC user name.

3 For the Output file, select the path and the name for the PDF file that you are 
creating.

Click the box with the three dots to the right of the Output file to bring up a Save 
PDF As dialog box. 
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4 If desired, fill in the optional Author Name, Creator, Keywords, Subject, and 
Title. 

5 Select a Font from the drop-down list.

6 Select a Font Size from the drop-down list.

◊ If you are printing landscape (11" x 8-1/2"), use a size like 8 or 8.5 points for 
the Courier or Courier New fonts. 

◊ If you are printing portrait (8-1/2" x 11"), use a size like 6 points or 6.25 points 
for the Courier or Courier New fonts.

7 Select a Paper Size from the drop-down list.

8 Select the Vertical Spacing from the drop-down list, or select the number of Lines 
per Page. The two drop-down lists are linked.

The Lines per Page and Vertical Spacing adjustment allow you to select how 
much text fits on each page. Thus, you can fine tune the line spacing for special 
forms, such as warrants or purchase orders.

9 For Rotate, select the number of degrees to rotate the print. 

10 For Left Margin, select how far in from the left side of the page you want each 
print line to be.

11 For Top Margin, select you far down from the top of the page you want the first 
line to print.

12 Create the PDF file by selecting either the [Create PDF (Ctrl + F1)] or the [Create 
PDF and Close (F3)] icons or options.

13 If Adobe Acrobat or Adobe Reader is installed on your PC, you can view the PDF 
file that you have just created.

14 Close the Create PDF dialog box.
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Opening a File in Word

To send a file to Word, either click the  [Open in Word] icon; or press [CTRL+W] 
from the Print Manager window, or press [CTRL+N] from the View window; or on 
the menu bar, click Options and Open in Word.

If a Convert File dialog box opens, select Text, then click [OK] to close the dialog 
box.

A Microsoft Word window will open. It contains the full text of the file in the View 
window. 

Orientation, font, and pitch are set on the Prefernces dialog box on page Page 2. 

• For portrait orientation, change the font size to 6 points.
• For landscape orientation, change the font size to 8 points. 

If you want to keep the print file as a Word file, save it under a different name. 
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Opening a File in Excel 
Sending a file to Excel does not work very well because Excel is unable to split the 
print file line into individual data fields.  Using the Excel Wizard option works better.

To send a file to Excel:
Click the  [Open in Excel] icon, press [CTRL+L], or from the menu bar, click 
Options and Open in Excel.

Sometimes Excel displays the following dialog box. If needed, respond to the dialog 
box by clicking [OK] to open the report in Excel. 

A new Microsoft Excel window will open.  The window displays a new worksheet 
with the contents of the selected file. Each line in the print file or spool file becomes a 
single cell in Excel. 

 Save the file in Excel format. 
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Opening a File with Excel Wizard
The Excel Wizard allows you to indicate where each data field begins and ends, how-
ever the Wizard works only for simple reports with a single detail line format that 
repeats for every record included in the report.  When the format of every detail line is 
identical, you can identify the various columns.

The Wizard does not work for reports that have multiple detail lines with different 
formats. However, you can use the Download option to extract information from a 
report like this, then create a comma- or tab-delimited file for importing into Excel. 

To send a file to the Excel wizard:
1  Click the [Open with Excel Wizard] icon, or press [CTRL+Z], or from the menu 

bar, click Options and Open with Excel Wizard

2 An Open dialog box displays. Press [Open] to continue to the next step.

3 Excel opens the first of three screens for the Text Import Wizard. This step allows 
you to define the type of file being imported to Excel.  

◊ For the Original data type, select Fixed width.

◊ If desired, select a row on which to begin the import. You can skip past the 
header rows and begin with the first row that contains actual report data.

◊ For the File origin, leave Windows (ANSI) as is.

◊ Select [Next >] to continue to the next step. 
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4 Define the data that goes in each column of the spreadsheet in the Text Import 
Wizard.

The wizard makes its best guess as to where each data item on the report begins 
and ends. Follow the instructions on the screen for creating, moving, or deleting 
column breaks. Use the horizontal and vertical scroll bars as needed to scroll 
through the data.

Select [Next >] to continue with importing data.

5 Define the data format for each column of the spreadsheet in the Text Import 
Wizard.
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Click a column to highlight it in black, then select the format for that column in the 
Column data format area. In most cases, the default choice of General will work.

After you have completed defining the column format, select [Finish] to import the 
file into a spreadsheet.

6 A Microsoft Excel window opens and displays the data you have just imported. 

After the import, you may need to make some adjustments, such as making col-
umns wider or narrower to fit the data. You may also want to delete the heading 
rows for each page. 

7 If you want to keep the Excel spreadsheet, save the file in Excel format. 

HINT: The General format removes all leading zeroes. If you want to maintain leading 
zeroes on accounts, site numbers, district numbers, and the like, use the Text format.
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Grid Output Window
The Grid Output window displays the contents of the grid that was active when you 
opened the window. It allows you to save the contents of the grid as a text file, print 
the grid, or save it as a PDF, Word, or Excel file.

  

Options Menu and Toolbar
The Options menu and Toolbar contain the commands for printing or saving the con-
tents of the data grid to a text file, PDF, Word, or Excel.  
      

The toolbar and Options menu 
contain the same commands. 
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Printing to the Default Windows Printer
If desired, click the  (Count Pages [Ctrl+F12]) icon to display the number of pages 
that will be printed. Close the dialog box to continue to the next step. 

♦ Click the  (Print [Ctrl+F11]) icon.  

♦ Make your selections in the Settings dialog box.

Delimiter Not applicable for this task.

Orientation Click Portrait or Landscape to select the page orientation 
when printing the grid.

Columns to 
remove

Highlight the columns that you want to remove when printing, 
the grid.

♦ After you are finished making selections, select [Continue] to print the grid on 
the default Windows printer for your PC.
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Creating a PDF File

1 Click the  (Create PDF [Ctrl+F]) icon.

2 Make your selections in the Settings dialog box.

Columns to 
remove

Click the columns that you want to remove from the PDF file.

3 After you are finished making selections, select [Continue] to continue to the next 
step and create the file in the same manner as previously discussed.
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Opening in Word

1 Click the  (Open in Word [Ctrl+W]) icon.

2 Make your selections in the Settings dialog box.

Delimiter Select the delimiter between columns in the Word file.

Orientation Click Portrait or Landscape to select the page orientation.

Columns to 
remove

Highlight the columns that you want to remove when exporting 
the grid.

3 After you are finished making selections, select [Continue] to continue to the next 
step and open a Word file in the same manner as previously discussed.
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Opening in Excel

1 Click the  (Open in Excel [Ctrl+W]) icon.

2 Make your selections in the Settings dialog box.

Orientation Click Portrait or Landscape to select the page orientation.

Columns to 
remove

Highlight the columns that you want to remove when exporting 
the list. 

After you are finished making selections, select [Continue] to continue to the next 
step and open an Excel file in the same manner as previously discussed.
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Opening in Excel Wizard

1 Click the  (Open in Excel Wizard [Ctrl+Z]) icon.

2 Make your selections in the Settings dialog box.

Delimiter When opening in Excel Wizard, the Grid Output window 
always creates a tab-delimited file.

Orientation Not applicable to this task.

Columns to 
remove

Highlight the columns that you want to remove when saving, 
printing, or exporting the list.

3 After you are finished making selections, select [Continue] to continue to the next 
step and open an Excel file in the same manner as previously discussed.
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Downloading Files 
The Download window allows you to select the parts of the report that contain the 
data you want to extract, then build a comma- or tab-delimited extract file that you 
can import into a spreadsheet or database program. For multi-line report formats, you 
can create record complexes that combine two or more lines in the report. 

 

     
Table 2-1: New Parts of the Download window 

PART OF WINDOW PURPOSE

Text area Displays the report that you selected on the Print Manager win-
dow or View window. You can select text for defining masks in 
the Selection Criteria tab and for defining ranges to output on the 
Column Output tab.

Report Settings Retrieve presets for previous downloads, save new presets, and 
select options for exporting a report. You can create a library of 
presets to save time for reports that you download regularly.

Selection Criteria 
tab

Select the lines of the report that contain the data for building the 
extract file. You can create up to 9 groups for including the rele-
vant lines of the report . Each group has an Include rule that 
defines the line to select. 

Column Output tab Select the specific data to include in the download file. Each field 
in the download file contains a specific bit of data from the report.

Title bar
Menu bar

Toolbar

Text area

Report Settings

Selection Criteria 
tab and Column 

Output  tab

Status bar

Message bar
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Downloading a Report from Scratch
These instructions give an overview of how to use the Download window to extract 
information from a report and create a download file. Once you have found the right 
settings for downloading a report, you can save them in a preset file so you don’t have 
to reinvent the process the next time you want to download the same report.

To download a report from scratch:
1 Become familiar with the report.

The text area allows you to study the report to become familiar with the informa-
tion that is on it and how it is organized. If the report has multiple detail lines, 
become familiar with how each group of lines is organized. If the report has a 
varying number of detail lines, understand the relationship among the header lines 
and the detail lines under them.

2 Define the selection criteria for extracting information from the report.

The Selection Criteria tab allow you to select the data lines to extract from the 
report. You can define groups of report lines to select. Each group has an Include 
rule with a mask that selects the report lines that are part of the group. A mask 
defines a pattern to match, such as 4 digits in columns 10 - 13, a blank space in col-
umn 14, and a letter from A through Z in column 15. You can also define SubSet or 
Exclude rules to fine tune the report lines selected for downloading.

3 Define the columns from the report to include in the download file.

The Column Output tab allows you to define the fields, or pieces of data, that go 
into each record of the download file. Each field is made from a range of columns 
in the report. such as getting the SSN from columns 1 - 11, the last name from col-
umns 13 - 28, and work phone number from columns 59 - 70.

4 Save the download in a preset.

It can take a good deal of trial and error to get a download to work the way you 
want it to, especially for complex reports with multi-line formats. Save your work 
in a preset file so that you can reuse the download settings for this report.

5 Create the download file. You can export the download file directly to Word, 
Excel, or PDF. You can also create a text file. 
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To retrieve and use a preset:
1 Select a preset file in the Report Settings area.

2 Examine the Download window and decide if you need to change any of the set-
tings in the preset file.

3 Create a text file, or export the data to Word, PDF, Excel, or Excel Wizard. 

4 If appropriate, save the preset file. If you have made changes to the Download 
window, you can save your changes back to the original preset file, or you can cre-
ate a new preset file.  

Download File Options Menu and Toolbar Icons
Table 2-2 summarizes the commands on the Options menu and the Toolbar icons 
within the Download File option.  For every command on the Options menu, there is 
an equivalent Toolbar icon. 

As you move from one part of the Download window to another, menu commands 
and toolbar icons change from available to unavailable and from unavailable to 
available. 

  

Table 2-2:  Options Menu and Toolbar Icons

OPTIONS MENU 
COMMAND

ICON KEYBOARD 
SHORTCUTS

PURPOSE

Save Preset... F9 Save the report processing rules in the 
Download window as a preset that you can 
reuse later.

Get Preset... CTRL+T Get a preset that you have previously 
saved.  

Send to Quick 
Report...

CTRL+Q Open a window that previews what the 
download data looks like. .

Create PDF... CTRL+F Download data from the report and save it in 
a PDF file.

Open in Excel... CTRL+X Open a Microsoft Excel spreadsheet that 
contains data extracted from the report. 

Open with Excel 
Wizard...

CTRL+Z Use the Text Import Wizard to import the 
download file into Excel. 

Open in Word... CTRL+W Open a Microsoft Word document with data 
from the report. 
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Grid Output SHIFT+F11 Open a Grid Output window that displays 
the contents of the tab with the green dot in 
its label.

Edit Mask  CTRL+M From the Selection Criteria tab, open a 
Mask definition form for group dialog box 
that allows you to define a mask for includ-
ing, excluding, or defining a subset of report 
lines.

Clear Form
 

SHIFT+F1 Clear all of the rows in the active tab (the 
one that has a green dot in its label).   

Move Column 
Row Up  

CTRL+U In the Column Output tab, move the current 
row up one row.

Move Column 
Row Down  

CTRL+D In the Column Output tab, move the current 
row down one row.

Remove Row CTRL+W Remove a row from the Column Output tab.

Create Raw 
Mask No Group

CTRL+F6 For the Selection Criteria tab, create a raw 
mask (the actual text selected) without 
assigning it to a group.

Create General 
Mask No Group  

CTRL+F7 For the Selection Criteria tab, create a gen-
eral mask (wildcards for the selected text) 
without assigning it to a group.

Create Group 
Raw Mask  

CTRL+F1 For the Selection Criteria tab, create a raw 
mask (the actual text selected) in a new 
group.

Create Group 
General Mask

CTRL+F2 For the Selection Criteria tab, create a gen-
eral mask (wildcards for the selected text) in 
a new group.

Add Raw Mask 
to Group  

CTRL+F3 For the Selection Criteria tab, add the 
selected text in the report to the current 
group as a raw mask (the actual text 
selected).

Add General 
Mask to Group

 CTRL+F8 For the Selection Criteria tab, add the 
selected text in the report to the current 
group as a general mask (wildcards for the 
selected text).

Select Column 
Range  

CTRL+F5 For the Column Output tab, add the 
selected range of columns to the current 
row in the tab.

Table 2-2:  Options Menu and Toolbar Icons

OPTIONS MENU 
COMMAND

ICON KEYBOARD 
SHORTCUTS

PURPOSE
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Text Area

The text area allows you to browse the report selected from the Print Manager win-
dow or View window. You can use this area to get a sense of the design of the report 
and what you want to get out of it.

The text area is used to select the text for creating a mask on the Selection Criteria tab 
or for defining a column range on the Column Output tab. 

Selecting a Range of Text
1 Highlight the text that you want to select.  Note that the line and column location 

of your selected text is displayed in the Status Bar above the Text Area.

2. Select the text to use for building a mask or column output range.  You can select the text 
with the mouse or the keyboard. 

Print Screen F11 Print a graphic image of the Download win-
dow on the default Windows printer for your 
PC.

NOTE: All column ranges must be on the same line of text. The screen will not allow a 
selection to span two or more lines.

Table 2-2:  Options Menu and Toolbar Icons

OPTIONS MENU 
COMMAND

ICON KEYBOARD 
SHORTCUTS

PURPOSE

The status bar displays the 
range of columns selected in 
the text area.

Selected text in 
the text area.
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Report Settings

The Skip Blank Lines check box allows you to select whether to process blank lines.  
Normally, you should check this option, as the blank lines contain no information.

The Delimiter list allows you to select the delimiter, or separator, between fields for 
exporting to PDF, Word, or a text file. The commands for Excel (Open  in Excel... 
and Open with Excel Wizard...) always open with a tab-delimited file.    

Selection Criteria Tab
The Selection Criteria tab becomes active after you click its label. The green dot indi-
cates that it is the active tab. Each row in the Selection Criteria grid allows you to 
define the rules for selecting the parts of the report that contain the data to be included 
in the download file. You can define up to 24 rules for each download.

Columns on the Tab
These instructions tell how to fill in the columns on the Selection Criteria tab. 

Group The group with which a rule is associated.  The options are a 
blank group or groups assigned to the letters A - J.

Lines The number of report lines in each group, which is 1 - 10.

Table 2-3: File formats for downloading to Word, PDF, or a text file

CODE EXTRACT FILE FORMATTING

N None. There are no separators between the individual fields in the download file. Each field 
is identified by the column ranges. 

C Comma-delimited. Each field is separated by a comma. This is a standard import format 
used by many PC databases and spreadsheets.

B Blank. The download file inserts a space between fields. 

T Tab delimited. Each field is separated by a tab character. This is a standard import format 
used by many PC databases and spreadsheets.
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Option The Option defines the type of rule.

♦ An Include rule defines the report lines included in each 
group. Every group has one, and only one, Include rule.

♦ One or more SubSet rules are optional for groups A - J. 
They act as filters on the report lines selected by the 
group’s Include rule.

♦ Exclude rules are optional. 

◊ If you are using the blank group, Exclude rules are fil-
ters for selecting report lines to exclude from the 
download file.

◊ If you are using groups A - J, you can create global 
and group Exclude rules. Global Exclude rules 
exclude report lines from all groups. Group Exclude 
rules exclude report lines from specific groups.

Mask A pattern for identifying the lines selected by a rule. A mask 
uses special characters to match patterns in report lines. 

MASK MATCH IN REPORT LINE 

blank Not used for matching. Any character in the 
report line matches a blank in the mask.

# A digit from 0 through 9.

@ Any characters that is not a space (digits 0 - 9, 
letters, punctuation, and special characters)

~ A blank column on the report.

any other 
character

Exact match. The match is case sensitive. 
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Blank Group
Groups are optional on the Selection Criteria tab. If you leave the Group column 
blank, the selection criteria are limited to one group that contains a single line. 

1 The first line in the Selection Criteria tab must have the following:

◊ A blank Group
◊ A Line depth of 1
◊ An Option of Include
◊ A Mask that includes at least 1 character other than a blank space

2 The blank group cannot include any of the following:

◊ Additional Include rules. 
◊ SubSet rules. 

3 You can define optional Exclude rules to filter the lines that are selected by the 
Include rule.

Groups A - J
Groups A - J can include multiple lines in a group. 

1 If desired, exclude report lines from all groups with optional Global Exclude rules.

2 Create one or more groups.  Group A is required. Groups B - J are optional. 

3 Create one Include rule for each group in the Selection Criteria tab. 

The Include rule has the following:

◊ A Group letter from A - J
◊ A Line depth from 1 - 9
◊ An Option of Include
◊ A Mask that contains at least one non-blank character

4 Create optional SubSet or Exclude rules for a group. You can create up to a total of 
24 SubSet or Exclude rules. If you define both Exclude and SubSet rules, the sys-
tem applies the Exclude rules first.  Each rule has the following:

◊ A Group letter for which you have created an Include rule.
◊ The Lines number of 1.
◊ An Option of SubSet or Exclude.
◊ A Mask that contains at least one non-blank character.
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Global Exclude Rules
Global Exclude rules allows you to exclude lines from all groups. If a report line 
matches any Global Exclude rule, it is excluded from all groups.

• Leave the Group blank.
• Make the Lines 1.
• Select the Exclude option.
• Define a Mask with at least one non-blank character.

Order for Processing Rules
The order for processing rules is different for the blank group and groups A - J.

Blank Group
• The system selects all report lines that match the Include rule.
• The Exclude rules act as filters. 

Groups A - J
1 The system applies Global Exclude rules first. .

2 The system applies the selection rules for each group. 

• The Include rule selects all report lines that match its mask.
• The optional Exclude rules remove all report lines that match any one of the 

Exclude rules.
• If there are SubSet rules, the only report lines that remain in the group are those 

that match any one of the SubSet rules.

3 If you have defined multiple groups, the system builds a record complex.

• A report line that matches group A.
• Within group A, all report lines that match group B.
• Under each pair of group A / group B lines, group C includes report lines that 

match the selection rules for group C.
In-depth QCC Print Manager Webinar (09/2012)  43 Copyright © QSS, 2012



In-depth QCC Print Manager Webinar Downloading Files
Creating Groups and Masks 
The Download window allows you to create groups and masks in the Selection Crite-
ria tab by selecting text from the text area.  The following commands are used for this 
process.      

General Steps for Creating a Mask and/or a Group
1 Select text in the text area.

2 Click the appropriate icon from the table above. 

3 A new row will be added to the Selection Criteria tab.

4 Edit the row as needed. 

Raw Masks
A Raw Mask is created by selecting from the report displayed in the text area the 
actual words, numbers, or symbols that you want included in your download.  Raw 
Masks can be assigned to either no group or to an A - J group. 

Table 2-4: Commands on the Options Menu for the Download window 

MENU COMMAND ICON KEYBOARD 
SHORTCUT

PURPOSE

Options | Create 
Raw Mask No 
Group

CTRL+F6 Create a new row with a raw mask (the 
actual text selected) without assigning it to 
a group.

Options | Create 
General Mask No 
Group

CTRL+F7 Create a new row with a general mask 
(wildcards for the selected text) without 
assigning it to a group.

Options | Create 
Group Raw Mask

CTRL+F1 Create a new row with a raw mask (the 
actual text selected) in a new group.

Options | Create 
Group General 
Mask

CTRL+F2 Create a new row with a general mask 
(wildcards for the selected text) in a new 
group.

Options | Add Raw 
Mask to Group

CTRL+F3 For an existing group, add the selected 
text in the report to the current mask as a 
raw mask (the actual text selected).

Options | Add 
General Mask to 
Group

CTRL+F8 For an existing group, add the selected 
text in the report to the current mask as a 
general mask (wildcards for the selected 
text).
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If we wanted to select the following highlighted text to be included in our mask....

A sample Raw Mask with no Group would look as follows: 

General Masks

A General Mask is created by using wildcards to define various fields of data which 
are of a certain length and located in a certain position on the face of the report.  The 
wildcards which are used to do this are as follows: 

A sample General Mask for the same data field would appear as follows:

In this case, the mask is ####-@@@@@@@. This mask selects any line that 
matches the pattern of 4 digits in columns 24-27 (####), a space in column 28 (~), 
and a string of non-blank characters in columns 29 - 36 (@@@@@@@@).

MASK MATCH IN REPORT LINE 

blank Not used for matching. Any character in the 
report line matches a blank in the mask.

# A digit from 0 through 9.

@ Any characters that is not a space (digits 0 - 9, 
letters, punctuation, and special characters)

~ A blank column on the report.

any other 
character

Exact match. The match is case sensitive. 
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A - J Group 

If we wanted to include either of the two above sample masks in an A Group, we 
would add the letter ’A’ to the first column on the Selection Criteria rab.

Editing the Mask
The Mask definition form for group dialog box allows you to edit masks for selecting 
report lines.  It displays after you click the Mask column in the Selection Criteria tab. 

• The column counter identifies the column in the report line for each special 
character in the mask. 

• The mask uses the same special characters for defining a pattern as discussed 
earlier.

Editing the Mask
1 Place the cursor where you want to begin typing or editing by clicking a position in 

the mask or by using the LEFT or RIGHT ARROW keys to move to the desired 
location.

The Character Position indicator displays the column number for the cursor.

2 If needed, select Insert or Typeover mode by pressing the INSERT key on your 
keyboard to toggle between Insert On and Typeover mode.

3 Add, change, or delete characters from the mask as needed.

Menu and 
toolbar commands

Column counter
Mask

Mode indicator

Character 
position 
indicator
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Displaying the Selected Report Lines
The [Send to Quick Report...] command allows you to display the list of report lines 
selected by the rules on the Selection Criteria tab. You can use this command to see if 
the Selection Criteria rules are working as expected. .

To display report lines selected on the Selection Criteria tab:
1 Fill in the Selection Criteria tab with a minimum of one Include rule. You can also 

define optional Subset and Exclude rules.

2 From the Download window, open a Quick Report window. 

3 Review the report lines selected.

The Quick Report window displays the report lines that match the rules on the 
Selection Criteria tab. You can use the scroll bars and standard Windows keys to 
navigate through this window.

4 If you want to refine the selections criteria, return to the Selection Criteria tab, 
modify the rules, and repeat Step 2 and Step 3.

5 If desired, save the contents of the Quick Report window in a text file. 

6 After you are satisfied with the rules on the Selection Criteria tab, close the Quick 
Report window. 

NOTE: If the Column Output tab is filled in, the Quick Report window displays the data 
selected for the download file.
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Column Output Tab
The Column Output tab allows you to define the specific fields in the download file. 
You can use the following to select the part of the report to use for building each field:

• The group and line number for selecting the report line, as defined on the Selection 
Criteria tab.

• The beginning and ending column in the report. 
• An optional edit rule, such as stripping the hyphens between the parts of the SSN 

or removing all parentheses and hyphens from phone numbers.

Filling In the Tab
There are a couple of ways to define the fields in the download file:

• Type the information directly in the Column Output tab.
• Add rows to the Column Output tab by selecting text in the text area. 

Group Link The group that is the source for the data in the column.

Line The line number in the group from which to extract the data.

Begin Col 
End Col

The range of column numbers from which to extract the data.

Option Leave blank to make no edits to the report data when creating 
the download file.

• Select Move Trailing Minus to edit negative numbers 
with a trailing minus sign.

• Select Move Trailing Minus - Left Justify to edit nega-
tive numbers with a trailing minus sign. 

• Select Upshift to make all letters from A - Z upper case.
• Select Downshift to make all letters from A through Z 

lower case.
• Select Remove Special Characters to remove all char-

acters other than the letters A - Z and the numerals 0 - 9.
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• Select Remove all non-numbers to remove all charac-
ters other than the numerals 0 - 9 and the decimal point. 

• Select Change Year to YY/MM/DD to change the date 
to year, month, day order with a 2-digit year.

• Select Change Year to YYYY/MM/DD to change the 
date to year, month, day order with a 4-digit year..

Defining Columns from the Text Area
These instructions tell how to use text area to select a range of columns for defining a 
field in the download file on the Column Output tab.

1 Select text in the text area by highlighting it.

2 Click the  [Select Column Range] icon, or press [CTRL+F5].

Fill in the dialog box which displays to assign the selected column range to a group 
and line number defined on the Selection Criteria tab.

◊ From the Group list, select the group from which to select the data.

◊ From the Line # list, select the line number in the group from which to extract 
the data.

Previewing and Saving the Download File
 You can use the [Send to Quick Report...] command to preview the contents of the 
download file. .

To display report lines selected on the Column Output tab:
1 Fill in the Column Output tab.

NOTE: If the Column Output tab is blank, the Quick Report window displays the report lines 
selected by the rules on the Selection Criteria tab.
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2 From the Download window, open a Quick Report window.  

3 Review the download file produced by the column definitions in the Column Out-
put tab.

The Quick Report window displays the download file. The format looks different 
depending on the choice of Delimiter.

When there is no delimiter, the download file makes all selected fields into one 
continuous string. 

For a space-delimited file, there is a space between each field. However, each field 
can have embedded spaces as well. 
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For a comma-delimited file, there is a comma separating each field in the down-
load file.

 For a tab-delimited file, the separator between each field is a tab. 

4 If you want to refine the column definitions, return to the Column Output tab, 
modify the rules, and repeat Step 2 and Step 3.

5 If desired, save the contents of the Quick Report window in a text file for import-
ing into a spreadsheet or database. You can also export the download file to Word, 
PDF, Excel, or Excel Wizard directly from the Download window.  

6 After you are satisfied with the rules on the Column Output tab, close the Quick 
Report window. 
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Presets
A preset is a file that saves the options you used for filling in the Download window.  
Once you have figured out how to structure a download of a report, you can save the 
download options in a preset file for future use.

Saving a Preset
After you select the Save Preset command, the Preset Maintenance - Save dialog box 
allows you to save a preset. The top of the dialog box allows you to give a name to the 
preset you are saving, and the grid in the bottom of the dialog box lists the presets that 
are already defined.      

To save a new preset:
1 Define the download definition that you want to save. Then select Save Preset 

from the Options menu, or click the  [Save Preset] icon. or the [F9] hotkey. 

2 In the Preset Maintenance - Save dialog box, type a Name up to 16 characters 
long. Every preset must have a name.

Commands for 
saving presets

Boxes for naming 
and categorizing 
the preset

Grid of presets that 
have already been 
saved. Double-click 
any column heading 
to sort in ascending 
order. Double-click 
again to sort in 
descending order.
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3 If desired, type a Description up to 30 characters long and select the Category and  
Allow Access options.   

4 Save the preset by clicking Save from the Options menu, by clicking the  [Save] 
icon, or by using the [F9] hotkey .

To replace a preset:
1 Define a a download definition that you want to save. 

2 Locate the preset that you want to replace on the grid.

3 Double-click the preset. Its Name, Description, Category, and Allow Access 
option display on the top of the dialog box.

4 Leave the Name unchanged. You can change the Description, Category, and 
Allow Access options. Replace the existing preset with the revised preset by 
selecting Save from the Options menu, by clicking the  [Save] icon, or by using 
the [F9] hotkey. 

To create a new preset from an existing one:
1 Define a download definition that you want to save. 

2 On the grid, locate the preset that is the basis for creating a new one. 

3 Double-click a preset in the grid. Its Name, Description, Category, and Allow 
Access option display on the top of the dialog box.

4 On the top of the screen, type a new Name. You can also change the Description, 
Category, and Allow Access options.

5 Save the new preset by selecting Save from the Options menu, by clicking the  
[Save] icon, or by using the [F9] hotkey.

WARNING: If the preset you are saving has the same Name as an existing preset, the 
Save command replaces the existing preset without any warning. 
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Retrieving or Deleting Report Presets
After you select the Get Preset command or icon, a Preset Maintenance - Retrieve 
dialog box displays. It lists all of the presets that have been saved for downloads. .

To select a report preset for retrieving or deleting:
1 By default, the dialog box displays presets for all categories. You can select an 

individual category from the Only list this Category box.

2 You can sort the list by any column. Double-click to sort in ascending order (A to 
Z). Double-click a second time to sort in descending order (Z to A).

3 Click a preset or use the UP ARROW or DOWN ARROW to select it. To retrieve 
the selected preset, click the  [Retrieve] icon, press [F2], or double-click it.  

4 To delete the selected preset, click [Delete] on the Options menu, click the  
[Delete] icon, or press CTRL+F8.

Commands for 
retrieving presets

Grid of the  presets 
that you can 
retrieve or delete

List for selecting a 
category of presets
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